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Warranty and Assistance 
 
The CD295 DataView II dual line display and PC295 software are warranted by Campbell 
Scientific Australia Pty. Ltd. to be free from defects in materials and workmanship under normal 
use and service for twelve (12) months from date of shipment unless otherwise specified. 
Campbell Scientific Australia’s obligation under this warranty is limited to repairing or replacing (at 
Campbell Scientific Australia’s option) defective products. The customer shall assume all costs of 
removing, reinstalling and shipping defective products to Campbell Scientific Australia. Campbell 
Scientific Australia shall return such products by surface carrier prepaid. This warranty shall not 
apply to any Campbell Scientific Australia products which have been subjected to modification, 
misuse, neglect, accidents of nature or shipping damage. This warranty is in lieu of all other 
warranties, expressed or implied, including warranties of merchantability or fitness for a particular 
purpose. Campbell Scientific Australia is not liable for special, indirect, incidental or consequential 
damages.  
 
The CD295 has no user-serviceable parts and must be returned to Campbell Scientific Australia or 
an authorised agent of Campbell Scientific Australia for repair. Products may not be returned 
without prior authorisation. To obtain a Returned Material Authorisation (RMA) number, please call 
+61 7 4772 0444. After an application engineer determines the cause of the problem, an RMA 
number will be issued. Please write the RMA number together with a description of the problem on 
documentation accompanying the returned product. Campbell Scientific Australia’s shipping 
address is as follows: 
 
Campbell Scientific Australia 
16 Somer St 
Hyde Park 
QLD, 4812 
Australia 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CCCCAMPBELL AMPBELL AMPBELL AMPBELL SSSSCIENTIFIC CIENTIFIC CIENTIFIC CIENTIFIC AAAAUSTRALIAUSTRALIAUSTRALIAUSTRALIA PTY. LTD. 
 
phone: +61 7 4772 0444  postal address: P.O.Box 444 Thuringowa Central QLD 4817 
fax: +61 7 4772 0555  delivery address: 16 Somer St, Hyde Park QLD 4812 
email: info@campbellsci.com.au www: www.campbellsci.com.au    ABN 48 060 048 062 



3 

DataView II 

DUAL LINE DATA DISPLAY 
FOR CR200 SERIES DATALOGGERS 

TABLE OF CONTENTS      

DataView II 1 

Warranty and Assistance 2 

TABLE OF CONTENTS 3 

INTRODUCTION 4 

SHIPPING KIT 4 

SPECIFICATIONS 4 

INSTALLATION PROCEDURE 4 

HARDWARE 5 
OVERVIEW 5 
MOUNTING 5 

SOFTWARE 7 
COMPUTER SYSTEM REQUIREMENTS 7 
SOFTWARE INSTALLATION 7 

PC295 8 
INTRODUCTION 8 
OPERATION 8 
ONLINE HELP 10 

DEVICE CONFIGURATION (DEVCONFIG) 11 
INTRODUCTION 11 
OPERATION 11 

TROUBLESHOOTING 14 

TEMPERATURE EXTREMES AND LCD ADJUSTMENT 15 

Appendix A – CD295 Door Kit Assembly Diagram 16 

Appendix B – CD295 Mounting Template 17 
 



DataView II (CD295) – Dual Line Display 
 

 
 

4 

INTRODUCTION 

The DataView II is a two line, 32 character LCD 
that displays real time values from a CR2xx series 
datalogger along with a pre-defined description 
string and units string. 
 
Two buttons allow the user to scroll through the 
programmed locations that are updated as often 
as they are measured. When the user has not 
pressed a button within a user-defined period 
(default 120 seconds),  the DataView II switches to 
low power mode, drawing a current of less than 
1mA.  
 
The DataView II is easily configured using the 
Windows based PC295W & DevConfig packages. 
 
N.B. Throughout this document the terms ‘DataView II’, 
‘CD295’ and ‘DataView2’ are used interchangeably.  

SHIPPING KIT 

The CD295 Dataview Shipping Kit includes: 
 

CD295 Dataview II display 
CD295 programming cable 
PC295 software on CD 
CD295 Manual 
CD295 MountingTemplate 
4 x stainless steel mounting screws, dome 
nuts, stainless steel and rubber washers. 

 
If the CD295 is to be mounted in the front door of 
an enclosure the CD295 door kit will also be 
included. This kit includes: 
 
 CD295 stainless steel door 

stainless steel screw with nylon spacer, 
PTFE, rubber and stainless steel washers, 
and “nylock” nut 
CD295 door mounting diagram 

SPECIFICATIONS 

Physical 
Width:  130mm   
Height:  100mm 
Depth:  30mm 
Weight:  235g 
 
Power Supply 

8-16Vdc (12V nominal) 
 
Power Consumption (at 12Vdc) 

Active with backlight - 30mA 
  Active without backlight - 3mA 
  Asleep - 1mA 
 

Communications 
    Physical protocol - RS232 DTE 
    Network protocol - PakBus 
    Configuration protocol - DevConfig 
 
Environmental 
    Temperature 

Operating -20oC to +55oC 
Asleep     -25oC to +70oC 

    Humidity 
Inside enclosure  

0-90% (non-condensing) 
Outside enclosure  

IP65 when mounted in enclosure 
door with supplied sealant. 
 

General 
    No of screens 30 max 
    Value update interval 1 – 65535 sec 
    Backlight period 0 – 60 secs (default 10) 
    Power down period 5 – 254 secs (default 120) 

(255 = never sleep) 
 
    CD295 address 1 – 4094 (default 4090) 
    Logger address 1 – 4094 (default 1) 
 
    Description string 16 chars max 
    Units string  8 chars max 
    Decimals  0 – 6 digits after decimal 

INSTALLATION PROCEDURE 

Below is a general guide to the steps involved in 
configuring and programming a DataView II 
(CD295) 
 

1. Using the CD from the CD295 shipping kit, 
install PC295W and DevConfig on your 
computer. 

2. Connect the programming cable’s 9pin D-
connector into the CD295 data cable and 
the other end into your PC’s serial COM 
port. 

3. Using PC295W and the CR200 datalogger 
program, write your Dataview II 
configuration program (DV2 file). 

4. Using DevConfig send the DataView II 
program (DV2 file), and change any 
settings necessary (Pakbus Address). 

5. Remove the programming cable. 
6. Mount the CD295 into your datalogger 

enclosure. 
7. Connect the CD295 data cable to the 

datalogger’s I/O port. 
8. Power-up the datalogger and CD295 and 

verify correct operation. 
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HARDWARE 

OVERVIEW 
Below is a general description of normal operation 
of the DataView II (CD295). 
 
When first powered up, the DataView II displays 
the following greeting, 
 

Campbell 
Scientific 

 
and the backlight will be lit.  
 
After some time (default 10 secs), the backlight will 
turn off, however the text will remain visible until 
the unit enters sleep mode (default 120 secs). 
Whenever one of the buttons on the front panel is 
pressed, these two timers (Backlight timer and 
Power Down timer) are both reset. As a result, the 
DataView II can be woken from sleep mode by 
pressing either of the buttons. 
  
After a program has been successfully 
downloaded, the CD295 is configured and 
connected to a CR200, it is ready for general use. 
Pressing one of the buttons on the CD295 will 
cause the LCD to display something like the 
example below. 
 
 

Temperature 
1.234   deg C 

 
 
The top line contains a string referred to as the 
‘Description’, and the second line contains both 
the value retrieved from a Public Variable in the 
datalogger and a string referred to as ‘Units’. The 
value displayed on the second line can be 
displayed with a user-selectable number of 
decimal places. 
 
Together, the combination of ‘Description’, Public 
Variable, ‘Units’ and number of decimal places, is 
referred to as a ‘screen’. The CD295 is capable of 
holding and displaying up to 30 ‘screens’. There 
are no limitations on the order of screens, or which 
Public Variables are displayed. Pressing the 
buttons on the front panel of the DataView II will 
cause the next (or previous) screen to be 
displayed. 
 
The CD295 will attempt to collect a new value from 
the datalogger under the following conditions: 
 

• The user has changed ‘screen’ 
• the scan interval of the datalogger has 

expired 
 

While in sleep mode the DataView II will continue 
to respond to PakBus communications, however 
the LCD is turned off and no requests are sent to 
the datalogger. 

MOUNTING 
The CD295 can be mounted in either of two ways, 
in the enclosure door or mounted on the Enclosure 
backplane. 
 
If the DataView II will be mounted in the enclosure 
door and exposed to the elements, it is important 
to also fit the CD295 door kit, as explained below. 
 
IN THE ENCLOSURE DOOR 
 

1. Use the template provided to mark out the 
four mounting holes and cut-out for the 
CD295.  

 
2. Drill the four corner holes using a 4.5mm 

drill and cut out the mounting hole using a 
jig-saw or nibbler.  

 
3. Apply a thin coating of neutral-cure silicon 

sealant between the flange of the CD294 
and enclosure door. 

 
4. Use the screws and nuts provided to 

attach the CD294. Insert the head of the 
screw followed by a flat washer through 
the front of the CD294. On the inside of 
the enclosure, fit the rubber o-ring washer 
then the second flat washer followed by 
the dome nut. 

 
N.B. If you are fitting the CD295 door kit, only 3 bolts are 
required to be fitted at this step. The bolt in the top-left 
corner of the CD295 front panel is not required. In this 
case, only fit the remaining three bolts, and use the 
longer (30mm) bolt supplied in the door kit in the top-left 
hole. 

 

 
 

Description 

Value 
Units 
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MOUNTING THE CD295 DOOR KIT 
 

1. If fitted, remove the nut, bolt and washers 
from the top-left mounting hole of the 
CD295 front panel. 

 
2. Remove the ‘nylock’ nut, stainless steel 

and rubber washers from the bolt 
assembly fixed to the CD295 door. At this 
point, the Bolt assembly holding tag 
should be exposed. 

 
3. Insert the bolt assembly through the top-

left mounting hole of the CD295 front 
panel 

 
4. From the inside of the enclosure, fit the 

rubber washer, stainless steel washer and 
‘nylock’ nut onto the stainless steel bolt 
assembly. 

 
5. After confirming that all hardware has 

been fitted in the correct order, tear off the 
‘Bolt Assembly Holding Tag’. 

 
6. Tighten the ‘nylock’ nut until the black 

rubber washer is tightly compressed. 
 
N.B. Do not overtighten as this will cause damage to 
rubber  washer. 
 
See Appendix A for the assembly diagram for the 
CD295 door kit. 
 
ON THE BACKPLANE 
 
The CM295 is an optional backplane mounting kit 
available from Campbell Scientific Australia. The 
CM295 allows the CD295 to be mounted on a 
punched metal backplane as supplied with 
standard Campbell Scientific enclosures. 
 

 
 
 
 

OPTIONS 
 
CM295 Backplane mounting kit includes the 
following: 

 
Aluminium c-section mounts 
4 x screws, washers,  nuts and backplane 
grommets 
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SOFTWARE 

COMPUTER SYSTEM 
REQUIREMENTS 
Minimum Configuration 
 
PENTIUM-class machine with 64MB RAM running 
Windows 98.  
 
Recommended Configuration 
 
PENTIUM-class machine with 128MB RAM 
running Windows 2000/XP. 
 

SOFTWARE INSTALLATION 
 
1. To begin the installation of the PC295 software, 
insert the PC295 CD into your computer, and 
locate and open the setup.exe file which contains 
the software to be used. 
 

 
 
2. After starting Setup.exe you will be presented 
with a welcome screen giving a brief introduction 
to the software. Click OK. 
  

 
 
3.  The next screen asks where you would like 
PC295 installed on your hard disk. If you wish to 
install into a path other than the default, Click 
“Change Directory” and use the windows dialog to 
choose a suitable location. Once the path is 
correct, click the Install icon in the top left corner of 
the window. 
 

 
 
4.  The next dialog to appear asks which program 
group on the start menu, you would like to add 
PC295. The default is usually acceptable, however 
if not, you are free to choose your preferred 
program group in this step. Click Continue. 
 

 
 
5.  File copying will now begin. 
 

 
 
6.  Once the Setup is complete, the following 
window is displayed. You are now ready to start 
using PC295. Click OK. 
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PC295 

INTRODUCTION 
 
PC295 software is a freeware utility provided by 
Campbell Scientific Australia to write programs for 
the DataView II. 
 
PC295 first reads the CR200 program (CR2 file), 
to generate the list of Public Variables, and to 
determine the scan rate of the datalogger. Once 
this information has been determined, the user is 
able to choose a public variable to display, and 
can associate ‘Description’ and ‘Units’ strings with 
it to form a ‘screen’. A group of screens forms a 
user program, and PC295 saves this program to 
disk in a DV2 file.  
 
By default, the first part of the filename is the same 
as the CR200 program from which it was 
generated. So for example, if you opened 
station1.cr2 to create the DataView II program, 
PC295 would save the program as station1.dv2.  
This naming convention is strongly recommended, 
but not mandatory. 
 

OPERATION 
 
1. To start PC295, Click Start > Programs > 

PC295W DataView2 Programming Software > 
PC295W DataView2 Programming Software. 

 
2. Once the PC295 program starts you will see 

the main screen.  
 

 
 
3. The first step in creating a Dataview II 

program is to select ‘Create new Dataview2 
Program’ from the File menu. This will open a 
file browser window which will allow you to 
locate the CR200 datalogger program (with 

CR2 extension). When the correct CR200 
program is selected, Click Open. 
 
If you already have created a DataView II 
program that you wish to edit, select ‘Open 
Existing Dataview2 Program’ in the File Menu. 
A file browse window will appear. Locate your 
Dataview II program (DV2 extension), and 
Click Open. 

 

 
 
4. If you have chosen to ‘Create a new 

DataView2 program’, a file browse window will 
appear.  
 
To operate correctly, your DataView II needs 
some information about the program running 
in the datalogger to which it will be connected.  
 
PC295 reads the CR200 program file you 
select at this step, and extracts information 
such as the Scan Interval and the list of 
Public variable names. 
 
Locate the CR2 program and select Open.  

 

 
 
5. PC295 will now return to the main screen, 

however the ‘CR2 FileName’ and ‘DataView 2 
Refresh Rate’ will no longer be blank. PC295 
has read your datalogger program, and is now 
ready for you to create a DataView II program. 
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Select the ‘Add Screen’ button. 
 
‘Variable to Display’ has a drop-down list, from 
which you are able to choose a Public 
Variable used in the datalogger program. 

 

 
 
6. The ‘Description’ and ‘Units’ fields are free-

form text strings that are displayed on the 
CD295 along with the value collected from the 
datalogger. These fields can be used to 
provide a user friendly description and 
engineering units of the value displayed. It is 
also possible to choose the number of decimal 
places to be used when displaying the value. 

 
Complete the Description, Units & Decimal 
places. 

 

 
 

You can now continue adding screens by 
repeating steps 5 & 6, as many times as 
necessary. 

 
7. If at any time you would like to return to an 

earlier screen, you can do so by using the 
‘Screen Number’ drop down. Also, if you 
would like to delete a screen you can select 
the screen you would like to delete from the 
‘Screen Number’ drop down and click the 
‘Delete Screen’ button. 

 
 
8. After entering all of the screens in your 

DataView II program, you will probably want to 
save your work. Click  File > Save As and this 
will open a dialog in which you can specify a 
filename and save your Dataview II program. 

 
If you are modifying an existing program or 
have already saved your work, you can select 
the ‘Save’ option which will not prompt for a 
new filename.   
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9. Once you have completed and saved the 

DataView II program, you are ready to 
download the program into the Dataview II 
itself.  

 
N.B. To do this you must have the ‘Device 
Configuration’ utility installed on your computer.  Please 
ensure that it is installed before proceeding. 

 
To continue with programming the DataView II 
(CD295), please refer to the section of this 
manual titled ‘Device Configuration’. 
 
From within PC295, ‘Device Configuration’ can 
be started through the file menu. Click File > 
‘Program a Dataview2 with a DV2 file’. 

 

 
 

ONLINE HELP 
 
PC295 has two items on the Help menu – ‘PC295’ 
and ‘About’. About lists the version number of the 
PC295 software, and ‘PC295’ contains online help 
to guide you through operation of the software. It is 

a simple step by step guide to writing your 
DataView II program. 
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DEVICE CONFIGURATION 
(DEVCONFIG) 

INTRODUCTION 
Device Configuration (DevConfig) is a freeware 
utility provided by Campbell Scientific for the 
configuration of Pakbus devices. This tool allows 
the user to send programs, upgrade firmware in 
the device, and modify device settings.  
 
In the case of the CD295, DevConfig allows you to 
download your program, and read/modify the 
following settings: 
 
    Version 
 the operating system version number 
    CD295 Address  

the PakBus address of the DataView II 
    Logger address  

the PakBus address of the datalogger 
from which the CD295 should collect 
values 

    Logger Security Code 
the security of the datalogger – this should 
always be 0 for the CR200 

    Power Down Timer 
the period of time after which the CD295 
should return to sleep mode 

    Serial Number 
the serial number of the DataView 

    Backlight Timer 
 the period of time to keep the backlight on 
 
Before using DevConfig, it is important to provide 
power to your DataView II (CD295) and connect 
the serial port of your computer to the CD295, 
using the programming cable provided (see figure 
below). 
 

 

OPERATION 
Establishing a Connection 
 
1. Start the ‘Device Configuration’ utility. 
 
2. Select CD295 from the ‘Device Type’ on the 

left hand side of the window. Verify the Serial 
Port in the bottom left of the window is correct 
and Click the ‘Connect’ button. 

 

 
 
3. DevConfig will automatically detect the 

connection speed and PakBus address of the 
DataView II. Once detection is complete, 3 
tabs should appear in the window on the right-
hand side. These are ‘Program Control’, ‘Send 
OS’ and ‘Settings Editor’.   
 
The ‘Program Control’ tab is used to send a 
program to the DataView II, and is the most 
commonly used of the three tabs.  
 
As the name suggests, the ‘Send OS’ tab is 
used to send an Operating System (OS) to the 
DataView II. This is used to upgrade the 
firmware of the CD295. 
 
The ‘Settings Editor’ tab is used to read/modify 
the addresses & timers mentioned above.  

 
Downloading a Program 
 
1. To download a program, ensure that you are 

already connected to the CD295 and the 
‘Program Control’ tab is selected. Click the 
‘Send Program’ button. 
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2. A file browser window will appear. Locate the 

DV2 file you wish to download and Click 
Open. 

 
N.B. When a DataView II program is created, PC295 
creates two files – the DV2 file for download to your 
DataView II, and a .295 file which contains internal 
configuration information for the PC295 program. You 
should only send the DV2  file to your CD295. 
 

 
 
3. DevConfig will download your program to the 

DataView II and return to ‘Program Control’. 
 

 
 
Modifying Settings 
 
1. The ‘Settings Editor’ tab allows you to 

read/modify any device-specific settings in the 
CD295. To change a setting, double click the 
settings you wish to change, and type the new 
value. Repeat for as many settings as 
necessary. 

 
N.B. Some settings are read-only, and others have limits 
on the range of acceptable values. A description along 
with the maximum and minimum values appears in the 
comments box at the bottom of the window. 
 
2. After all changes are complete, Click Apply to 

send the new settings to the DataView II. After 
the settings are applied, DevConfig will show 
the new values of the Settings from the 
CD295. 

 

 
 
3. If after editing a setting, you wish to discard 

the changes, Click Cancel. DevConfig will 
show the current values of the settings, in 
order for you to verify that the changes were 
discarded. 
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4. It is possible to return the DataView II to it’s 

factory default settings. To do this, Click 
‘Factory Defaults’. 

 
Upgrading the Operating System (OS) 
 
From time to time, new operating system(s) for the 
DataView II may be released to correct errors in 
the operating system, or to add new functionality. 
To take advantage of this, it is necessary to send 
the new operating system (OS) to the DataView II. 
 
1. If you need to send a Operating System to 

your Dataview2, open the ‘Send OS’ tab in 
‘Device Configuration’ and select the Send OS 
button at the bottom of the window. 

 
N.B. It is not necessary to ‘Connect’ using DevConfig to 
send an operating system. 

 
 
2. A file browser window will appear. Locate the 

operating system file (A43 extension), 
provided by your supplier, and Click Open. 

 
3. After selecting the operating system file, it will 

be necessary to power cycle the DataView II. 
Disconnect the power from the CD295, and 
reconnect it. 

 
4. The download will begin, and progress bar 

should begin to fill.  
 
N.B. It is VERY important that the power cable and 
programming cable remain connected while the 
download is underway. Failure to do so, may cause 
permanent damage to the CD295. 

 
 
5. When the download is complete, DevConfig 

will display a popup to confirm the success or 
to notify if there was an error.  

 

 
 
6. Once the download is complete, disconnect 

power from the CD295 for at least 30 seconds 
to ensure that it has been completely reset. 
After this, the new operating system will run. 
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TROUBLESHOOTING 

 
• Symptom 
 

The DataView II displays ‘Waiting’ in every 
location. 

 
Explanation 
 

This message indicates that the DataView 
requested a public variable from the 
datalogger, but has not yet received a 
response.  

 
Things to check 
 
Is the DataView II connected to the 
datalogger? 

 
Check the serial cable from the 
DataView II to the datalogger. 

 
Does the datalogger have power? 

 
Check the power supply to the 
datalogger. 

 
Does the PakBus address of the datalogger 
match the ‘Logger Address’ in the CD295? 

 
Using DevConfig, check that the 
‘Logger Address’ setting in the 
DataView II and the Pakbus address 
of the datalogger match (refer to your 
datalogger manual). 

 
Is this the right version of the DataView 
program for the datalogger program? 
 

It is important that the program that is 
running in the datalogger is the same 
as the one used when the DataView II 
program was written. If not, then the 
DataView II program may need to be 
re-written. 

 
Could the datalogger be too busy to answer? 
 

Consider the execution of the 
datalogger program, and modify if 
necessary. 

 
• Symptom 

 
The DataView II displays ‘Waiting’ in a few 
(but not all) screens. 
 
Explanation 
 
This message indicates that the DataView 
requested a public variable from the 

datalogger, but has not yet received a 
response.  
 

If some screens function correctly, then 
the logger address, is correct, and the 
datalogger is answering requests 
correctly. 

 
Things to check 
 
Is this the right version of the DataView 
program for the datalogger program? 
 

It is important that the program that is 
running in the datalogger is the same 
as the one used when the DataView II 
program was written. If not, then the 
DataView II program may need to be 
re-written. 

 
• Symptom 

 
After sending a program to the DataView II, it 
displays ‘No program’ and won’t show any of 
my screens. 
 
Explanation 
 
The ‘No program’ message indicates that the 
current program in the DataView II is 
incomplete or incorrect. 
 
No permanent harm is done by sending an 
incorrect file, however it will not execute. 
 
Things to check 
 
Did you download the correct file? 
 

It is very important that you select the 
DV2 file that you created with PC295, 
and not the 295 file which is only 
created for internal use by the PC295 
software itself, or any other file on 
your computer. 
 
Try downloading again. 

 
Could your DV2 file be corrupt? 
 

No software other than PC295 should 
be used to edit DV2 files. Even a slight 
change to the file is enough to cause 
the CD295 to reject the program. 

 
Try recreating the DV2 file in PC295, 
and download it again. 
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TEMPERATURE EXTREMES AND 
LCD ADJUSTMENT 

The CD295 has been tested to –20ºC. It will 
perform at this temperature although the display 
may be sluggish and dim.  
 
Under temperature extremes, the CD295’s liquid 
crystal display (LCD) may become difficult to read. 
LCD contrast can be adjusted by inserting a small 
jeweller’s screwdriver (preferably plastic) into the 
round hole on the back of the CD295 cover and 
adjusting the LCD contrast potentiometer. 
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Appendix A – CD295 Door Kit Assembly Diagram 
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Appendix B – CD295 Mounting Template  

(NOT TO SCALE – REFER TO MOUNTING TEMPLATE SUPPLIED WITH CD295) 

 
 

 


